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1  INTRODUCTION

OVERVIEW OF WIN-SITU 4

Win-Situ™ 4 is easy-to-use software that connects your desktop or laptop
computer to In-Situ’s miniTROLL and Multi-Parameter TROLL 9000.

For field use on a hand-held computer (PDA), optional Pocket-Situ
provides all functionality and features in a field-portable platform.

Use Win-Situ or Pocket-Situ to

• Set up a direct connection between a PC and one or more devices
• Set up a modem or radio connection to one or more devices
• Convert pressure measurements to depth or level readings
• Check the device’s clock, pressure range, memory, and battery
• Set up custom data collection schedules (“tests”)
• Take continuous real-time readings (profiling), or “manual” readings
• Monitor low-flow parameters to determine stabilization of water-quality

indicators
• Extract data from a device
• View, graph, and print test data files; transfer to Microsoft® Excel®

• Calibrate the MP TROLL 9000 to monitor water quality
• Upgrade device firmware (when available)

TIP: To
communicate with
In-Situ’s TROLL

4000, Multi-Parameter
TROLL 8000, and HERMIT
3000, use Win-Situ 2000.
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PROGRAM REQUIREMENTS

WIN-SITU

Win-Situ requires a desktop or laptop computer running Microsoft®

Windows® 95 or later with a serial communications port and a CD-ROM
drive.

POCKET-SITU

Pocket-Situ runs on supported hand-held PDAs with

• Operating System: Microsoft Pocket PC, Pocket PC 2002, or Pocket
PC 2003, also known as Windows Mobile 2003

• a serial communications port for connection to the instrument,
• a Secure Digital (SD) memory card (16 MB minimum, 32 MB

preferable) for application and data storage—required for most
supported PDAs but not needed for the Rugged Reader, as all
storage is in non-volatile memory.

Pocket-Situ requires the following to interface with a desktop or laptop PC
for installation and data file retrieval:

• Microsoft® ActiveSync™ installed on the desktop or laptop PC,
• Win-Situ installed on the desktop or laptop PC.
• USB or serial cable to connect the computers.

For more information on setting up a PDA, refer to Section 10 of this
manual.

SECTION 1: INTRODUCTION
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SECTION 1: INTRODUCTION

INSTALLATION

WIN-SITU

The Win-Situ CD-ROM contains an automatic setup program to install
Win-Situ to your local hard drive.

1. Insert the Win-Situ 4 CD in the appropriate drive of your computer.

• If the CD-ROM drive is set to Auto-Play, the installation program will
start automatically.

• If necessary, choose Run from the Windows Start Menu and type
D:\Setup, where D is your CD-ROM drive letter.

2. Follow the instructions to install the program to your local hard drive. A

shortcut will be created on the desktop:   

POCKET-SITU

To install Pocket-Situ on a handheld PDA:

1. Be sure Win-Situ 4 and Microsoft® ActiveSync™ are installed on the
desktop PC, and that a partnership has been established between the
desktop computer and the PDA. For more information on setting up
partnerships in ActiveSync, see your ActiveSync documentation.

2. Install Pocket-Situ on the desktop PC from the Win-Situ/Pocket-Situ
installation CD. Install it to the folder where Win-Situ is installed.

3. When ActiveSync detects the connection, the PocketSync utility will
start automatically. When prompted to install Pocket-Situ on the
connected PDA, answer Yes. For more detailed installation information
see Section 10 of this manual. For more information on the
PocketSync utility, see PocketSync’s on-line help.

TIP: Be sure
Microsoft
ActiveSync is

installed on your desktop or
laptop PC before attempting
to install Pocket-Situ. You
will need to connect the
computers and set up a
partnership in ActiveSync
before you can install
Pocket-Situ on a PDA.

TIP: The CD
menu option is
“Install Pocket-

Situ,” but you are actually
installing PocketSync to
your desktop computer in
preparation for installing
Pocket-Situ on a connected
handheld PDA.
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2  GETTING STARTED

STEP 1: CONNECT THE
INSTRUMENT TO THE PC

1. Attach a communication interface
to the surface connector of the
instrument’s quick-connect cable.

2. Attach communication interface to
a PC’s standard RS232 serial port
(a serial cable, serial card, and/or
a null modem may be needed with
some PDAs).

STEP 2: LAUNCH THE
SOFTWARE

• Double-click the Win-Situ shortcut created on the

desktop during installation. 

• Or double-tap the Pocket-Situ 4 shortcut on the
PDA Start Menu.

Communica-
tion interface

Serial port
PDA

Quick-
Connect
submersible
cable

miniTROLL
or
TROLL 9000
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The application window appears. A new, empty site called “Home” is
displayed at the top of the Navigation tree. The Connection Wizard starts
to helps you specify the properties of this connection.

STEP 3: ADD A CONNECTION

A connection is simply a COM port on your computer. The Connection
Wizard helps you specify the properties of this connection, including—

• Connection type:
• Direct, for use when the In-Situ data logging device is

attached directly to the PC
• Modem for a dial-up modem
• Spread-Spectrum Radio

SECTION 2: GETTING STARTED

TIP: The first time
you launch the
software, the

Connection Wizard helps
you add a connection to the
“Home” site.  If the Wizard
does not start automatically,
select the site and click or
tap Add.
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• Devices connected: Select “one” to speed up connection to a
single device, or “more than one” for a network.

• Port: Select the COM port (RS232 serial port) to which the device
is attached. For a Modem connection, enter the phone number—up
to 40 characters; a comma designates a pause.

• Baud Rate: Select any rate (19,200 is the default); baud rates are
automatically synchronized between devices and the host PC.

• Name (optional): A default connection name is suggested.
• To have the wizard connect automatically, be sure the option

Connect and find devices on “Finish” is checked.

STEP 4: FIND DEVICES

1. If you requested Win-Situ to connect and find devices, go to step 3.

2. To connect manually, click Find. Or double-click the connection.

SECTION 2: GETTING STARTED

To  connect manually,
click here

TIP: You will use
this one
connection setting

regardless of the number of
individual instruments to
which you will be
connecting, so there is no
need to create multiple
connection settings.
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3. The following will happen:

• Win-Situ synchronizes the baud rate of the device to the host PC.
• Win-Situ “finds” (connects to) the device(s). For a modem connec-

tion, Win-Situ initiates a phone call.
• The status bar at the bottom of the screen shows the state of

communications between Win-Situ and the device.
• After the connection is made, the device appears in the Navigation

tree.
4. Click to select the device in the Navigation tree. If more than one

device was located, select the one you want to talk to first. Note the
device information shown on the right side of the screen.

SECTION 2: GETTING STARTED

TIP: If the device
does not appear in
the tree, there may

be a communication
problem between Win-Situ
and the device. Check (1)
the COM port, (2) the
hardware connections, (3)
the device’s battery or
external power.

4



13

 0031510  rev. 003  11/04

STEP 5: SET THE CLOCK

Data collection schedules depend on the device clock. Set it as follows:

1. With the device selected, click or tap Edit....

2. In the Device Wizard, select Clock.

3. Select Syncronize Device Clock to Computer Clock. Note that you
may set the device clock “manually,” if desired.

4. When you finish the Wizard, the information is sent to the device and
the display is updated.

SECTION 2: GETTING STARTED

Device clock
(on desktop PC)

Click here to set
the clock

TIP: Due to the
size of the PDA
screen, the

device clock is not shown in
the interface. We recom-
mend you edit the device
as above to synchronize
the device clock to the PDA
clock.
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THE NEXT STEP

The next step depends on the connected device and how you intend to
use it.

• Quick-Cal the water-quality sensors. Complete instructions are given in
Section 3 of the Multi-Parameter TROLL 9000 Operator’s Manual.

• Set up the pressure parameter channel to display the type of readings
you want. See Section 5 for information.

• Section 7 has details on profiling.

• See Section 8 for details on programming your device to collect data.

EXITING THE SOFTWARE

WIN-SITU

Select Exit from Win-Situ’s File menu.

POCKET-SITU

Tap the Home site in the Navigation tree., then tap Exit in the command
bar at the bottom of the screen.

If changes have been made to the site, Win-Situ or Pocket-Situ will ask if
you want to save the modifications. Such modifications may include
adding or deleting a connection as well as measurement units and other
preferences, which are saved with the site.

• Select Yes to save the current settings.
• Select No to abandon the changes.

For more information on settings, see Choosing Measurement Units and
Other Preferences in Section 4.

SECTION 2: GETTING STARTED

CAUTION: Be
sure to Exit
Pocket-Situ as

described here after each
session. This releases
allocated resources used by
Pocket-Situ, so that the
communications port will be
available the next time you
connect to an In-Situ
instrument, or to a desktop
PC using ActiveSync with a
serial connection.
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YOUR NEXT SESSION

Each time you start Win-Situ or Pocket-Situ, the site and the connection (if
any) saved in your last session are displayed in the Navigation tree.

To connect:

1. Select the connection.

2. Click Find. Or double-click the connection.

Win-situ will locate the device and display it in the Navigation tree.

Note: If the instrument is operating on battery power and the remaining
battery capacity is at 10%, a warning to replace the batteries will be
displayed before the device appears in the Navigation tree. Replace
the device’s batteries as soon as possible.

SECTION 2: GETTING STARTED

1

2

TIP: To start Win-
Situ from Windows
Explorer, double-

click a Win-Situ file in the
folder where Win-Situ is
installed. Win-Situ 4 files
have a .WS4 extension.

If the device’s
remaining battery
capacity is 5% or

less, the device may not be
displayed in the tree.
Replace the batteries
before continuing.
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3  THE NAVIGATION TREE

Win-SItu and Pocket-Situ use the familiar “navigation tree” to display your
instrument network. The tree appears on the left of the screen in Win-Situ,
at the top of the screen in PocketSitu. The remainder of the screen is an
Information pane with details about the “node” selected in the tree.

NAVIGATION TREE NODES

At the top of the tree is the “Home” site (the host computer). Below this is
the Flow-Sense Wizard (see Section
11), then the Data Folder
containing tests that have
been extracted from the
device to the host
computer. This is followed
by one or more connections
(COM ports), and then one or
more devices (e.g., miniTROLL,
MP TROLL 9000) accessible through each COM port. The Device node is
further expandable to show the parameters the device can measure and
the tests in the device memory. The symbol + means a node can be
expanded to show more nodes.

Site
Flow-Sense Wizard
Data Folder

Connection
Device

Parameters

Tests
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SECTION 3: THE NAVIGATION TREE

WIN-SITU 4 INTERFACE (DESKTOP OR LAPTOP PC)

TIP: In any view,
clicking the right
mouse button

displays a short, context-
sensitive menu listing the
same actions available on
the action buttons.

Navigation Tree

Actions

Information Pane

Device clock

TIP: Some actions
are not available
when a test is

running in the device.

Some actions are available
only after making a selec-
tion within the Information
pane.

When a node is selected,
• the Information pane displays information about the selection.
• available actions are presented on buttons in the Information

pane (Win-Situ) or the command bar (Pocket-Situ).
Each selection results in a unique “view” in the Navigation tree.
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SECTION 3: THE NAVIGATION TREE

POCKET-SITU INTERFACE (PDA)

TIP: Use the scroll
bars to view more
of the Navigation

tree and Information pane.
The screen can be resized
by using the stylus to drag
the bar separating the
Navigation tree from the
Information pane.

Actions

Navigation tree

Information pane

To resize the screen,
press on this area
with the stylus and
drag it up or down
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SITE VIEW

When a site is selected, connection(s) and current status are shown.

Site Actions

Add starts the Connection Wizard to
help you add a connection.

Delete deletes a connection (when
selected in the Information pane).

In Pocket-Situ, Setup and Exit are
available on the Command bar when the
Home site is selected (these appear on
menus in Win-Situ).

SECTION 3: THE NAVIGATION TREE

Node

Actions

Information
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DATA FOLDER VIEW

The Data Folder provides a convenient way to view tests that have been
extracted from the device to the host PC.

The Data Folder is empty, as indicated in the first screen below, until you
extract (copy) data from the device. See Section 8 of this manual for
information on extracting data from the device memory to the Data Folder.
To work with tests in the Data Folder, see Section 9.

SECTION 3: THE NAVIGATION TREE

TIP: The Data
Folder displays a +
to show it contains

data. The absence of a +
means there is no extracted
data in the folder.

Data Folder, empty

Data Folder with data.
Click the + to expand
the listings
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SECTION 3: THE NAVIGATION TREE

CONNECTION VIEW

When a connection is selected, its properties are displayed.

Connection Actions

Find opens the connection and locates connected devices.

Edit starts the Connection Wizard to help you change the properties of a
connection. This action is not available when the connection is open. After
the connection is made, this button changes to let you Drop the
connection.

Delete deletes the connection.

Node

Actions

Information
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DEVICE VIEW

With a device selected, the Information pane shows details about the
device: the date it was manufactured and calibrated, its hardware and
firmware versions, storage capacity (memory), battery status (based on
measured voltage), and more. This example shows a Professional model
miniTROLL. You may need to scroll to see everything on a PDA.

Device Actions

Edit starts the Device Wizard to help you enter a custom name, set the
clock, and update battery information.

Upgrade is available if you have an upgradable device, or if Win-Situ
detects a later firmware version than currently loaded in the device.

Refresh requeries the device and updates the display.

SECTION 3: THE NAVIGATION TREE

Device clock

Date of factory calibration

Available memory

“Wake” time since last battery
replacement or firmware
upgrade

Battery information

Device identification

Node

Actions

Information
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MULTIPLE PARAMETERS VIEW

To view a list of all parameters the device can measure, select the
Parameters node in the Navigation tree. This example shows a
Professional model MP TROLL 9000 with nine parameters.

Multiple Parameter Actions

Quick Cal (MP TROLL 9000) calibrates all the Basic water-quality
sensors simultaneously.

Profiler launches the software’s profiling function (Section 7).

Note: If you select one or more parameters in the Information pane, the
Read button is available for instant “manual” readings. Select multiple
parameters to read by holding the CTRL key while clicking.

SECTION 3: THE NAVIGATION TREE

Advantages of
the Multiple
Parameters View:

(1) This view provides
access to Quick Cal and
Profiler buttons, and (2)
multiple parameters can be
read simultaneously.
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SECTION 3: THE NAVIGATION TREE

SINGLE PARAMETER VIEW

To view more detail for an individual parameter—including the pressure
sensor range and recent calibration information for water-quality
sensors—and access more actions, view the single parameter display by
selecting the parameter of interest in the Navigation tree.

Note: It may be necessary to first expand the Parameters node by
clicking the + symbol.

Single Parameter Actions

Edit customizes pressure readings. See Section 5 for details.

Read displays an instant reading.

Calibrate invokes wizards to help you calibrate the water quality
parameters of a Multi-Parameter TROLL 9000.
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MULTIPLE TESTS VIEW

To view a summary of all tests in the device, select the Tests node in the
Navigation tree. Refer to Section 8 for more information on tests.

SINGLE TEST VIEW

To view the details of an individual test, expand the Tests node by clicking
the + symbol, then select the test of interest. Section 8 has complete
information on tests.

SECTION 3: THE NAVIGATION TREE

Advantages of
the Multiple Tests
View: (1) Group

actions can be performed
on multiple tests, (2) New
tests can be added to the
device, and (3) An existing
test definition can be
“Cloned” (copied).
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SECTION 3: THE NAVIGATION TREE

WIN-SITU MENUS AND TOOLBAR (DESKTOP PC)

File Menu—Use this menu to exit Win-Situ. It also has options to create a
new site, open a previously saved site, and save current connection
information in a new file.

Options Menu—Allows you to set preferences, including units for
displaying data.

Tools Menu—Launches the Baro Wizard, Flow Sense Wizard,
PocketSync, and displays Calibration reports.

Toolbar Buttons—provide quick access to useful operations:

Opens a new, empty site

Enlarges the Information pane to Full Screen;
changes to Split Screen to return to the dual
pane view
Show Calibration Report opens Calibration
results in an HTML file (MP TROLL 9000)

Launch PocketSync synchronization utility (if
installed in the same folder as Win-Situ)

Cancels the current locate or retrieve operation

Saves the current site information

Opens a previously saved site
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CHOOSING MEASUREMENT UNITS AND OTHER
PREFERENCES

Preferences can be set at any time, and are saved with the site. A
connection to the instrument is not required.

User-selectable preferences include:

• Parameter measurement units & elapsed time units
• Data file view—report or graph
• Calendar date & time of day format
• Metric or English units for the Flow-Sense Wizard

The following Settings Options are also available:

• Start the application in Profiler mode
• Use boxcar filtering during Profiling
• Specify desired Profiling rate
• Re-display the “Don’t Ask Again” dialogs

4  SPECIAL ACTIONS

TIP:  Preferences
are saved with the
site. If preferences

are changed during a
session, the software will
inform you, on exiting, that
the site has been modified.
Be sure to save the
modifications or the changes
will be lost.
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To display the Preferences window, do one of the following:

• In Win-Situ, select Preferences from the Options menu.
• In Pocket-Situ: Tap the Home site in the Navigation tree, then tap

Setup... in the command bar.

UNITS

Default units are used for the display of data unless you specify other
preferences. To set unit preferences, first display the Preferences window
as explained above.

1. Select the Units tab.

2. In the top of the Units window, select a parameter whose unit you wish
to change.

3. In the bottom of the window, select the unit you want for the highlighted
measurement. Repeat for as many units as you like.

4. Do one of the following:

• Click OK to apply the new units and close the window.
• Click the Settings tab to change other settings.

SECTION 4: SPECIAL ACTIONS
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OTHER PREFERENCES

To change other aspects of Win-Situ/Pocket-Situ operation, first display
the Preferences window as described above.

1. Click the Settings tab.

2. Select the options you want:

a Start device in Profiler mode. This will take effect at your next
session (or exit and re-start to apply this setting).

b Use boxcar filtering for Profiling. Boxcar filtering is described in the
appendix to the MP TROLL 9000 Operator’s Manual.

c Set desired Profiling rate—the Profiler default rate is 2 seconds, but
you may select any rate from 2 to 60 seconds.

d Re-display the “Don’t Ask Again” dialogs. This appears if you have
selected “Don’t ask me this again” in any of the following:

• Profiler Log Naming
• View Calibration Report after a Quick Cal
• View Calibration Report after a traditional calibration
• Verify Units in LowFlow
• Specify barometric pressure to use in absence of vented cable

3. Select OK to close the window and apply the settings.

SECTION 4: SPECIAL ACTIONS
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TAKING “MANUAL” READINGS

Devices collect data in “tests” but you can get a quick “manual” reading
from any device apart from a test, even while a test is running. This can
aid in positioning a pressure probe in a well, and also confirm that the
device is operating properly.

1. In the Navigation tree, click or tap Parameters.

2. In the Information pane, select a parameter.

3. Click or tap Read. A current reading will be displayed.

• Readings will be in default units until you specify your unit prefer-
ences (Win-Situ: Options menu; Pocket-Situ: Setup).

• If a test is running and the device is about to take a test reading,
the request may have to be sent several times.

SETTING A DEVICE NAME

The software recognizes a device by its serial number. In addition, you
can assign a meaningful description—such as a well or site name, location
coordinates, etc.—to be displayed in the Navigation tree and data files.

1. With the device selected in the Navigation tree, click or tap Edit....

2. In the Device Wizard, select Name.

3. Enter a new name for the device (up to 16 characters)

4. When you finish the Wizard, the information is sent to the device and
the display is updated.

SECTION 4: SPECIAL ACTIONS

TIP: For
continuously
updated real-time

“manual” readings of all
parameters, select the
Profiler in the Information
pane. Refer to Section 7 for
Profiler information.

TIP: For a
pressure
parameter In

Level display mode, two
readings may be shown.
For more information, see
Section 5.
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UPGRADING FIRMWARE AND FEATURES

FIRMWARE UPGRADE

New software releases may include a new version of firmware for the In-
Situ data-logging device. If the software detects a newer version of
firmware than that currently loaded in the device, you will be prompted to
upgrade device firmware when you connect. The upgrade process is brief
and software-assisted.

In order for the software to detect it, new firmware must be located in the
Firmware folder in the folder where Win-Situ or Pocket-Situ is installed.

Firmware is automatically copied to these locations when new software is
installed.

FEATURES UPGRADE

The miniTROLL and MP TROLL 9000 are available in several versions or
models, each offering a different feature set. Some models may be field-
upgraded to take advantage of a wider range of features. The field
upgrade involves keying in an upgrade code, issued by In-Situ when an
upgrade is purchased for a specific instrument serial number.

If you have an upgradable feature set, the Upgrade action will be available
in the Information pane when the device is selected in the Navigation tree.
If you have purchased a features upgrade for your instrument, press
Upgrade and key in the upgrade code issued by In-Situ Inc. Follow the
instructions in the Upgrade Wizard.

For best
performance, we
recommend you

upgrade to new firmware
when prompted by the
software.

TIP: If the
Upgrade button
is dim (not

available), the software
cannot upgrade firmware.

SECTION 4: SPECIAL ACTIONS
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5  PRESSURE SETUP

In-Situ’s MiniTROLL measures two parameters: pressure (water level) and
temperature. The Multi-Parameter TROLL 9000, when equipped with an
optional pressure sensor, also measures pressure. Options in the
Parameter Wizard let you tell the software exactly how you want to display
pressure measurements—as raw pressure head above the sensor, as
depth, or as water level with a reference.

ZEROING A GAUGED PRESSURE SENSOR

The following procedure may be used, with caution, to “zero” the offset of
a gauged pressure sensor to correct for electronic drift. The drifted offset
is visible when the sensor is in air and reading other than zero.

It is recommended you do not zero the offset if it is outside the specified
accuracy of your pressure sensor. For additional information on pressure
sensor accuracy, electronic drift, and factory recalibration, refer to the
miniTROLL Operator’s Manual and/or the Multi-Parameter TROLL 9000
Operator’s Manual.
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1. With the device connected to a host PC and selected in the Navigation
tree, click or tap Pressure in the Parameters list. If the pressure
channel is set up to display in Depth or Level mode, use the Edit
function to set it to Pressure Head mode.

2. Click or tap Calibrate. You will be prompted to ensure the device is in
air.

3. When the device is in air, click Yes.

The current pressure reading will be set to zero. To check this, take a
reading with the “Read” button.

SECTION 5: PRESSURE SETUP

1

2
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EDITING THE PRESSURE PARAMETER

The Parameter Wizard can help you configure a pressure channel to
display measurements just as you want them. The specified settings are
easily changed from one mode to another, and most choices can be
redone or undone later, when viewing test data.

1. In the Navigation tree, select a pressure parameter.

2. In the Information pane, click or tap Edit.

The choices are discussed below.

3. When you finish the Wizard, the information is sent to the device and
the display is updated.

NAME (OPTIONAL)

A default name is supplied for display in the Navigation tree and test data
files. If you choose, you can enter a custom name.

1

2

SECTION 5: PRESSURE SETUP

If the device is
running a test, the
Edit button will not

be available.
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DISPLAY MODE

Select one of the following. Subsequent screens
will be tailored to your choice.

• Pressure Head displays the raw pressure
exerted by the column of water above the
pressure sensor, in kiloPascals, pounds per
square inch, bars, or kilograms per square
centimeter. If you choose this mode, click
Finish to end the Wizard.

• Depth converts the pressure of the water
column to a depth reading, in meters,
centimeters, feet, or inches.

• Level - Surface: Commonly used for surface
water elevations. Data file readings are
“positive up.” Increasing water levels will result
in increasing readings. Decreasing water
levels correspond to decreasing readings.

• Level - Top Of Casing:  Commonly used for
drawdown in groundwater wells. This mode is
“positive down.” Decreasing water levels
correspond to increasing readings, because
the water level is getting further from the top of
the well casing. Increasing water levels result
in decreasing readings.

SECTION 5: PRESSURE SETUP

Depth
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LEVEL/DEPTH CONVERSION INFORMATION

The conversion from pressure in pounds per square inch (psi) to depth or
level in meters or feet requires several conversion factors.

Specific Gravity

A dimensionless specific gravity value may be used for the conversion
from pressure to feet or meters of fluid. A specific gravity of 1.0 (the
specific gravity of pure water at 4°C) is adequate for many groundwater
applications. The value is editable. Specific gravity values equate to liquid
density in g/cm3. (See the table in Appendix A.)

Density, Latitude & Elevation

If your software supports it, a more accurate conversion may be applied
whereby pressure in the English unit psi is first converted to the SI unit
Pascal (Pa), and then to meters or feet using two additional values:

• Liquid Density. Pure groundwater at 20°C has a density of 0.998 g/
cm3. Refer to Appendix A for a temperature/density table and a method
for experimentally determining liquid density if the working fluid is not
pure water.

• Gravitational Acceleration. The acceleration due to gravity that an
object experiences is location-specific. Given your latitude and
elevation, the software can calculate a value for gravitational accelera-
tion.

TIP: Either specific
gravity or density,
latitude & elevation

may be used to convert
from pressure (psi) to
depth/level (meters or feet).
If your software supports it,
a gain in accuracy may be
realized by selecting the
density, latitude & elevation
option.

SECTION 5: PRESSURE SETUP

TIP: To change
the units for
pressure, depth,

or level readings, select
Preferences from the
Options Menu (Win-Situ) or
select the Home site and
tap Setup in the Command
bar (Pocket-Situ).
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LEVEL REFERENCE

This is a user-specified starting point for level display modes. Here are
some examples:

• Surface: Calculate the water level above mean sea level (MSL) and
enter as the Level Reference. Data will be displayed as elevations
above MSL.

• TOC: Measure the distance to the water surface from the top of the
well casing (DTW) and enter as the Level Reference. Data will be
displayed as DTW values.

• A Level Reference of 0 is equivalent to “zeroing” the probe. Data will
be displayed as changes from the starting water level.

A current reading of the sensor depth is displayed in this screen; you can
reposition the probe and update the reading with the Update Reading
button.

Reference Time

The device takes a “snapshot” of the sensor’s raw pressure reading, then
your Level Reference is substituted. You can specify that the snapshot be
taken now or when the test starts. The data file will show the Reference
(raw pressure) Reading and when it was taken.

• Now: the pressure is measured when you click Finish, and the value is
stored until the test starts. All measurements taken during the test will
be relative to the water level at the time you finished the wizard.

• Start of Test: the Reference measurement will be taken at time t=0. All
measurements taken during the test will be relative to the water level at
the moment the test starts.

TIP: To display
“manual” readings
that take your

Level Reference into
account, select Reference
Time: Now.

SECTION 5: PRESSURE SETUP
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6  WATER-QUALITY SETUP

In-Situ’s Multi-Parameter TROLL 9000 can measure water-quality
parameters in addition to pressure and temperature.

A Calibrate button is available when a water-quality parameter is selected
in the Navigation tree. The calibration wizard will help you through the
calibration process.

Complete water-quality calibration procedures are beyond the scope of
this manual. Please refer to the MP TROLL 9000 Operator’s Manual.
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7  PROFILING

The Profiler delivers instant real-time readings on all available channels.
Profiler readings are continuously updated as long as the Profiler is
running. This provides a convenient means for quick characterization of
surface waters using a hand-held controller running Pocket-Situ.

PROFILER FEATURES

• Auto detect—the software automatically identifies all properly
connected sensors

• Continuously updated readings from all available channels
• Optional data logging to the connected PC
• Optional start device in Profiler mode
• Optional selectable Profiler interval (2-60 seconds)

You will need—

• miniTROLL or MP TROLL 9000
• Quick-Connect Submersible cable
• ComIT or comm cable
• PDA running Pocket-Situ

TIP: Pocket-Situ
screens are shown
in this section.

Win-Situ on a laptop PC
may also be used for
Profiling.
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SECTION 7: PROFILING

STARTING THE PROFILER

1. Connect the instrument to a PC and
establish communication in Win-Situ
or Pocket-Situ.

2. Select the device in the Navigation
tree.

3. Click or tap Parameters.

4. Click or tap Profiler to start the
Profiler.

5. You will be asked if you want to set
a filename for logged Profiler data
(logging the data is optional)

• To use the default name click OK.

• To specify another name, key it
in and click OK.

• To avoid this question each time
you start the Profiler, check the
option box and click OK.

In a moment, each active channel
will be read sequentially, and the readings will be displayed. Up to 8
channels can be shown.

TIP: If you set up
the software to
start in Profiler

mode, steps 1-4 are done
automatically when the
application starts. For
details on this setting, see
Choosing Measurement
Units and Other
Preferences in Section 4.

3

4

5

TIP: Don’t let the
PDA time out while
Profiling. To locate

this setting in most PDAs,
display the Start menu,
select Settings, System tab,
Power.
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SECTION 7: PROFILING

• Readings are updated approximately every 2 seconds (default), or
whatever interval you may have specified when setting up preferences.

• The current measurement unit is shown below each reading.

• A window without a reading indicates the channel is not available to
read, usually because there is no sensor installed in the port.

TIP: To change
unit preferences:
Close the Profiler.

In Win-Situ, select
Preferences on the Options
menu. In Pocket-Situ,
select the Home site, then
tap Setup... in the
command bar.

Close the Profiler and return
to the Parameter displayDisplay a graph of the data,

starting with the first channel

Log next set of
readings to the Data
Folder on the PC

Log continuously updated
readings to the Data
Folder on the PC.
Changes to “Stop Log”
during continuous logging.

Select a different
channel for display in
this position

Profiler logging status

Click any reading to
see a graph of the
channel
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SECTION 7: PROFILING

GRAPHING PROFILER DATA

To see a graph of any channel during the current Profiler session, do one
of the following:

• Click or tap any reading.

• Click or tap Graph, and select the channel from the drop-down list.

Readings for the selected channel since the start of profiling will be
displayed in graphical format.

The profiler can graph up to 300 readings. A range slider (scroll bar) on
the right side of the graph allows you to change the range of visible data.
Like the channel display, the graph will be continuously updated. A range
slider at the bottom of the graph lets you zoom in on a narrower time
period.

To switch back to the display of active channels, click Meter.

Y axis range
slider

Return to channel
display Close Profiler

Select a different channel
to graph

X axis range slider
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PROFILING WATER DEPTH OR LEVEL

Profiler readings from a pressure channel are displayed as pressure head
or depth according to the pressure channel setup. Refer to Section 5 for
pressure display and conversion options. Level mode readings with a
user-entered reference are primarily for use in long-term tests.

CUSTOMIZING THE PROFILER

Changing the Channel Order

The arrow below each profiler reading displays a drop-down list that may
be used to assign a different channel to each position, if desired.

Changing Measurement Units

Close the Profiler. In Win-Situ, select Preferences on the Options menu. In
Pocket-Situ, select the Home site, then tap Setup in the command bar.

Changing the Sample Rate

Close the Profiler. In Win-Situ, select Preferences on the Options menu,
then select the Settings tab. In Pocket-Situ, select the Home site, tap
Setup in the command bar, then select the Settings tab. You may select
any sample rate between 2 and 60 seconds.

Starting in Profiler Mode

In Win-Situ, select Preferences on the Options menu, then select the
Settings tab. In Pocket-Situ, select the Home site, tap Setup in the
command bar, then select the Settings tab. Check  ✔ Start application in
Profiler mode. This will take effect at your next session (or exit and re-start
to apply this setting).

SECTION 7: PROFILING

TIP: Profiling with
the device’s default
pressure settings

(no channel setup) will
display pressure head in psi
(pounds per square inch).
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SECTION 7: PROFILING

LOGGING PROFILER DATA

Profiler data may be logged to the connected PC while in the “Meter” view.

• SnapShot:  To log a single set of Profiler readings, click or tap the
Snapshot button in the “Meter” view.

• Continuous: To log continuous readings, click or tap the Continuous
button in the “Meter” view. Readings will be logged until you cancel the
operation by clicking Stop Log.

To Stop Logging

The Snapshot function logs one set of readings and stops automatically.

In Continuous mode, click Stop Log. Note that this does not stop
Profiling; readings will continue to be updated on the screen.

RETRIEVING LOGGED PROFILER DATA

In either Snapshot or Continuous mode, Profiler data are logged to the
connected PC and accessible through the Data Folder. The data may be
retrieved at any time. A connection to the instrument is not necessary.

To retrieve logged Profiler data:

1. Expand the Data Folder in the Navigation tree by tapping the +.

2. Expand the node for the device type and serial number.

3. Look for a data file named with date and time of the profiler reading,
and with the ending profiler.bin—or whatever custom name you may
have specified when starting the Profiler.

EXITING THE PROFILER

Click or tap Close. The Parameters view will return to the screen.

TIP:For additional
information on
viewing data in the

Data Folder, see Section 9,
Viewing Test Data. 
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8  LOGGING DATA

Collecting a set of data with an In-Situ instrument is called “running a test.”
Many things that you do through Win-Situ and Pocket-Situ can be
visualized as actions performed on Tests. For example,

• to give the device instructions for collecting data you add a test to the
device.

• when you want the device to end data collection you stop a test.

• to copy test data from the device to a host computer you extract the
test data.

These actions are initiated by buttons in the Information pane when the
device’s Tests node (group view) or a Single test is selected in the
Navigation tree.

Advantages of
the Multiple Tests
View: (1) Group

actions can be performed
on multiple tests, (2) New
tests can be added to the
device, and (3) An existing
test definition can be
“Cloned” (copied).
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SECTION 8: LOGGING DATA

ADDING A TEST TO A DEVICE: THE TEST WIZARD

1. Click or tap Tests in the Navigation tree.

2. Click or tap Add. The Test Wizard starts. The choices are discussed
below.

3. When you finish the Wizard, the information is written to the device and
the display is updated.

1

2

MP TROLL 9000 TIP: Before the Test Wizard starts, you will be
asked to specify whether the cable is vented or non-vented. Cable
venting is essential for accurate barometric pressure measurement.
In the absence of vented cable, a substitute barometric pressure
value may be supplied. For more information, please refer to
Section 9 of the MP TROLL 9000 Operator’s Manual.
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TEST SETUP PARAMETERS

A complete test definition has five parts. The choices available in each
screen are tailored to reflect your selection in earlier screens.

1. Test Name (Optional)

You may enter up to 16 characters to identify the test. A default name is
proposed. The test name is displayed

• in the Navigation tree
• in the test data file
• in the filename of tests extracted from the device to the Data

Folder on the host PC

2. Parameters to Include

All available parameters will be selected. De-select any channels you do
not want to measure. Remaining choices will be tailored to your selection.
For example, a log test is not available when water-quality parameters are
being measured with an MP TROLL 9000.

SECTION 8: LOGGING DATA
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3. Measurement Schedule

The available schedules depend on your device’s firmware and the
parameters selected for inclusion in the test. This list is a quick overview.
Additional details are given in Appendix B.

3a Linear. All measurements are evenly spaced at a user-specified
interval (prompted next), and all measurements are stored in the
device memory. This is the software’s default schedule.

3b Event. Measurements are evenly spaced, but you can record an
“event” and conserve memory by having the device store only
measurements that differ from the previous stored measurement of a
designated parameter by a specified amount. Any available parameter
may be selected for event comparisons, and the “delta” or difference
amount is prompted in the current parameter unit.

3c Log. Designed to capture early-time water-level data during aquifer
testing, measurements are very closely spaced at the start of the test
(about 3 measurements per second) and get further apart on a
logarithmically decaying schedule as the test progresses. All measure-
ments are stored in the device memory. Available for tests that
measure only pressure, depth, or water level.

3d Linear Average. This type of test can smooth out anomalous highs
and lows that may occur, for example, when a water wave passes over
the instrument. Each stored measurement is the average of several
rapid measurements.

SECTION 8: LOGGING DATA
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4. Measurement Interval

The measurement interval specifies how often measurements will be taken
during this test. You may enter any combination of Day, Hour, Minute,
Second, and for a miniTROLL, Hundredths of a second.

The minimum (fastest) allowable interval depends on your choice of
measurement schedule and the parameters included in the test.

SECTION 8: LOGGING DATA

Parameter miniTROLL MP TROLL 9000

Pressure 0.5 sec 5 sec
Water level 0.5 sec 5 sec
Temperature 0.5 sec 5 sec
Barometric pressure -- 5 sec
pH -- 5 sec
Conductivity -- 5 sec
ORP -- 5 sec
Dissolved oxygen (Clark) -- 5 sec
Dissolved oxygen (RDO) -- 10 sec
Turbidity -- 5 sec

Minimum Linear Measurement Intervals
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5. Start Mode

5a Manual. A manual start test can be started at any time while the device
is connected to a PC by pressing the Start button. This mode is useful,
for example, when you want to  synchronize the start of data collection
with an external event like starting a pump.

5b Scheduled. A scheduled start test will start at the date and time you
specify. The time proposed is 10 minutes ahead of the current device
time. You may use the arrows beside the list boxes to choose a start
time and date, or key in the desired start time and date.

ENDING SETUP

After you select the test options and click Finish, the information will be
sent to the device and the new test will appear in the Navigation tree.

To let you know which tests can be started with the Start button, the
software displays a different symbol for each start type:

Manual start test (you start)

Scheduled start test (starts by itself)

SECTION 8: LOGGING DATA

The time proposed
for a Scheduled
start is calculated

by adding 10 minutes to the
current device time. In
Pocket-Situ this is your only
indication of the device
time. If the proposed time
by this definition is wrong,
cancel the test setup and
set the device clock before
scheduling tests.

TIP: In entering the
Scheduled Start
time, keep in mind

that when this test starts, it
will automatically stop a
running test.

TIP: The end of a test cannot be programmed in advance.  In
most cases, the Stop button is the only way to end a test.
Exceptions: A test stops automatically (1) when another
scheduled test starts, (2) when the device memory is full; in this
case the test may indicate “ABEND” (ABnormal END) in the
Navigation tree, (3) if a loss of power occurs; in this case the test
may indicate “ABEND” in the Navigation tree.
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OTHER TEST OPERATIONS

There are six basic test operations:

• Add...—programs the instrument to collect data. See the first part of
this section for details.

• Edit...—allows you to change the pre-programmed test setup before
the test runs. Editing a test launches the Test Wizard, and the prompts
are the same as when adding a test.

• Start—starts the selected test if it has been defined for a manual start.

• Stop—stops a running test.

• Extract—copies the selected test data from the instrument to the host
computer.

• Delete—deletes the selected test from the instrument.

• Clone—makes a copy of the selected test definition setup.

SECTION 8: LOGGING DATA
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The operations available depend on the status of the test selected in the
Navigation tree. A dfiferent symbol is displayed for each test status:

Test operations are initiated by action buttons in two places:

• the Tests view, where information about all tests is displayed and
actions may be performed on multiple tests

• a single Test view, where actions may be performed for the selected
test

Pending test—manual start
Completed test
Running test
Pending test—scheduled start
ABEND test
    (came to an ABnormal END,
      e.g., by losing power or filling the memory)

Test Status Symbols

SECTION 8: LOGGING DATA
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STARTING A TEST
A test set up for a Scheduled start will start by itself, assuming the device
clock is correctly set. To start a Manual start test, proceed as follows:

1. In the Navigation tree, select a pending manual test .

2. Click or tap Start.  You will be asked to confirm your selection.

3. After you confirm, the test starts and the display is updated.

If a test is running in the device, the Start button is not available. You
must stop the running test before you can start a new one. See
“Stopping a Test” below.

STOPPING A TEST

The end of a test cannot be programmed in advance. In most cases, the
Stop button is the only way to stop a running test. Exceptions: A test stops
automatically when any of the following occurs:

• when another test starts
• if the device memory fills up
• if power is lost.

1. In the Navigation tree, select a running test .

2. Click or tap Stop. You will be asked to confirm your selection.

3. After you confirm, the test stops and the display is updated.

TIP: Once a test
starts, the following
actions will not be

available: Add, Delete, Edit
(device, parameter, test),
Calibrate.

SECTION 8: LOGGING DATA



54

 0031510  rev. 003  11/04

EXTRACTING LOGGED DATA

Retrieving, downloading, uploading, transferring—these terms are
sometimes used interchangeably to mean the act of copying data from the
place where it was logged to a host PC. The Extract operation in Win-Situ
or Pocket-Situ retrieves test data from the device memory and saves it to
a file on the host computer. You may view the file immediately after the
download, or later.

1. In the Navigation tree, click or tap Tests.

2. In the Information pane, select one or more tests to extract. To select
multiple tests, hold the CTRL key while selecting. (To display the CTRL
key on a PDA, tap the keyboard symbol in the Command bar.)

3. Click or tap Extract to extract the test(s).

When the extraction is complete, the name(s) and locations of the test
data file(s) on the host computer are displayed (see box on the next
page). If a selected test has been extracted previously, only data
logged since the last download is extracted and is automatically
appended to the original file.

The software presents two options after the extraction:

• View  launches the data viewer to view the selected file.
• Done returns to the Tests view in the software.TIP: “Extracting”

puts a copy of a
test data file on

your computer, but does not
delete the data from the
device. To free up device
memory, see Deleting
Tests, below.

TIP: When
extracting a large
test to a PDA on

battery power, don’t let the
PDA time out during the
transfer. To locate this
setting in most PDAs,
display the Start menu,
select Settings, System tab,
Power.

SECTION 8: LOGGING DATA

TIP: If your host computer is a PDA, be sure to install
Microsoft ActiveSync and In-SItu’s PocketSync on your
desktop PC to enable the transfer of data files to the desktop
PC for processing or archiving.
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SECTION 8: LOGGING DATA

Win-Situ \ Data \ SN00120  2004-06-18  083000  drawdown.bin

Device serial number

Test start date (yyyy-mm-dd)

Test start time (hhmmss)

Test name

TIP: Win-Situ saves each test to a folder named “Data” in the
folder where Win-Situ is installed. The file structure looks like
this:

File type

TIP: On a PDA, the Pocket-Situ \ Data folder is located
in the device’s non-volatile storage.

DELETING TESTS

Tests are stored in the device memory until you delete them. The Delete
operation permanently removes selected tests from the device, and
reorganizes the memory to optimize future data storage. Depending on
how full the memory is, the process may take several minutes.

1. In the Navigation tree, click or tap Tests.

2. In the Information pane, select one or more tests to delete. To select
multiple tests, hold the CTRL key while selecting. (To display the CTRL
key on the Pocket PC, tap the keyboard symbol in the Command bar.)

3. Click or tap Delete. You will be asked to confirm your selection.

4. After you confirm, the selected test(s) are permanently removed from
the device and the display is updated.

CAUTION: Be
sure to extract the
tests you want to

save before deleting them
from the device. Once a
test is deleted, the data
cannot be retrieved!

TIP: The Delete
procedure can be
used to cancel a

pending scheduled
test.

TIP:If a test is
running in the
device, the Delete

button is not available. You
must stop the running test
before tests can be deleted.
See “Stopping a Test”
above.
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CLONING A TEST

The Clone function lets you copy all the elements of an existing test—the
test name, selected channels, measurement schedule and interval—
without having to define a new test “from scratch.” You can clone a
pending test or a completed test.

1. With the miniTROLL connected to a host PC and selected in the
Navigation tree, click or tap Tests.

2. In the Information pane, select a test to clone.

3. Click or tap Clone to preview the test definition. The Wizard will still
present all the screens, but you can just click Next to get through them
quickly (or make any changes you want).

4. Click Finish to end the wizard. The information will be sent to the
device and the new test will appear in the Navigation tree.

SECTION 8: LOGGING DATA

TIP:The proposed
start type for a
cloned test will

always be Manual,
regardless of the start type
of the original test. This is to
avoid scheduling a test to
start in the past.
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Logged data from In-Situ instruments are called “tests.” Tests reside in the
instrument until you extract them to the host computer. Any test that has
been extracted can be viewed in text or graphical format. A test can be
extracted and viewed at any time, even while it or another test is running.

Win-Situ and Pocket-Situ provide two ways to view test data:

• If the test is in the instrument’s memory: Select the test in the
Navigation tree, Extract it, and select the View option at the end of
the download. (This process is described under the heading “Ex-
tracting Logged Data” in Section 8.)

• If the test has been extracted to the host computer, it will appear in
the Data Folder node in the Navigation tree. A connection to the
instrument is not required in order to view extracted data.

9  VIEWING TEST DATA
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SELECTING DATA IN THE DATA FOLDER

The Data Folder appears below the Home site in the Navigation tree. After
data files have been extracted from the instrument to the Data Folder, the
node can be expanded to show device type, serial number, and extracted
data files.

To view extracted test data:

1. Click the + sign beside the Data Folder to expand the listings.

TIP: If the + sign
does not appear,
this means no

tests have been extracted.
See “Extracting Logged
Data” in Section 8.

SECTION 9: VIEWING TEST DATA

1



59

 0031510  rev. 003  11/04

2. The Data Folder has a node for data from various device types—for
example, miniTROLL Pro Data, TROLL 9000 Professional XP Data. If
tests from more than one type of device have been extracted, click the
+ to expand the listings for the device type of interest.

3. Device nodes are further subdivided by serial number. If tests from
multiple instruments of the same type have been extracted, the serial
number of each will be displayed. Click the + beside the serial number
of the unit whose data you want to view.

SECTION 9: VIEWING TEST DATA

2

3
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4. The serial number node contains the extracted tests and logged
Profiler data. Click to select the test you want to view.

The selected test is displayed in the Information pane—to the right of
the screen in Win-Situ, or at the bottom in Pocket-Situ.

SECTION 9: VIEWING TEST DATA

4

TIP: The data file
may appear in
Report view or

Graph view, depending on
the preferences saved in
your last Win-Situ or
Pocket-Situ session.



61

 0031510  rev. 003  11/04

5. To view the test data below the header in Report view:

• Use the vertical and horizontal scrollbars to scroll through the data
file.

• Or click Full Screen in the shortcut bar to enlarge the text display,
and then use the scrollbars.

5

6

5 Enlarges the Information pane to full screen

SECTION 9: VIEWING TEST DATA
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GRAPHING DATA

6. With a test selected in the Data Folder, click or tap Graph to display
the individual parameter data in graph format.

Since the graphing controls available in Win-Situ and Pocket-Situ differ
somewhat, they are described separately below

WIN-SITU GRAPHING CONTROLS

The Graph button displays data from the first four test channels in graph
format. Time is shown on the X axis in the currently selected unit. The
axes are auto-ranged. Click any graph to select it for formatting.

SECTION 9: VIEWING TEST DATA

TIP:You can easily
switch from Graph
view to Report

view and back using the
Graph and Report buttons
in the Information pane.
However, the view chosen
in this way is not
“persistent” into your next
Win-Situ session. To
change the view so it
always comes up as Graph
or Report, specify the
desired Data File View in
Preferences (Options
menu) in Win-Situ or Setup
in Pocket-Situ.
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Each graph can display one, two, or all test channels. To change the
appearance and content of any graph, display the Graph menu or right-
click a graph. This provides access to the graph formatting options:

• change or add channels
• add data point indicators
• add grid lines to one or both axes
• add a logarithmic time scale
• change the range of the Y (data) axis
• change the parameter units
• add a time stamp to the X (time) axis
• zoom in on the graph

Many of these options can be set in the Graph settings window on the
Graph menu:

Win-Situ provides a range of options for viewing data in graph format.
Here are some things you may wish to try:

• To enlarge the selected graph: Click Full Screen in the toolbar, then go
to the Graph menu and select a different Number of Graphs

SECTION 9: VIEWING TEST DATA
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• To show two channels on the graph: select Graph Settings on the
Graph menu, select a Primary channel and a Secondary Channel

• To show all channels on the graph: select Graph Settings on the Graph
menu, choose All Channels Selected

Changing the Pressure Channel Setup

The View button in the data view launches a wizard to help you change
the way test data are displayed.

• Select Channels to view (Report view): Tap Next, then tap a check-
box to show or hide a channel. Finish returns to the Report view.

• Change Channel Settings: Redefine the display options for a
pressure channel. Refer to Section 5 for details on the settings.

• Change Units and other preferences.

SECTION 9: VIEWING TEST DATA

This graph was created with the following controls: Number of Graphs: One Graph, All
channels selected, Zoomed in on 11-22 minutes, Vertical grid.
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POCKET-SITU GRAPHING CONTROLS

On the Pocket PC, all channels in the test are displayed in one graph.
Time is shown on the X axis in the currently selected unit. The axes are
auto-ranged.

The left Y axis represents the first channel in the test (usually tempera-
ture), or the first channel selected in the View... option in the command
bar. The right Y axis represents the second channel.

Tap Graph or Text in the command bar to change the view.

The graph area may be resized as follows:

With the stylus (or other suitable pointer), press on the line that separates
the Navigation tree from the Information pane and drag it up or down to
resize the screen.

SECTION 9: VIEWING TEST DATA

TIP: Win-Situ calls
it “Report” view,
Pocket-Situ uses

the shorter word “Text”
view. They are the same

!

"

Test #7

Switch to text view

Pocket-Situ 4.00 8:00a

Text View... Baro...

To resize the graph,
drag the dividing line
with the stylus.

Select channels, change units
and other preferences

#$

!.......—
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SECTION 9: VIEWING TEST DATA

Changing the Data Display

The View... option in the command bar launches wizards to help you
change the way test data are displayed.

• Select Channels to View: Tap Next, then tap a check box to show or
hide a channel. Tap Finish to return to the graph. The Y axes will reflect
your selection.

• Change Channel Settings: Redefine the display options for a pressure
channel. Refer to Section 5 for details on the settings.

• Change Units and other preferences.
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SECTION 9: VIEWING TEST DATA

TRANSFERRING DATA TO EXCEL (DESKTOP PC)

1. In Win-Situ, select Report view.

2. On the File menu, select Export to Excel. If Microsoft® Excel® is
properly installed on your PC, the data file will open in an Excel
spreadsheet.

PRINTING DATA (DESKTOP PC)

To print the graph or report as currently displayed:

1. In Win-Situ, select Graph or Report view as desired.

2. On the File menu, select Print graph or Print report.

Addtional information is available from your printer documentation.

SAVING TEXT FILES (DESKTOP PC)

1. In Win-Situ, select Report view.

2. On the File menu, select Save Report.

3. In the window that opens, supply a filename in the usual way; the
report will automatically be given a .TXT file type.

TIP: The Export to
Excel, Save
Report, and Print

functions are not available
in Pocket-Situ. To use
these features, first transfer
the extracted data from the
PDA to a desktop PC as
described in Section 10.
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10 POCKET-SITU

Pocket-Situ provides instrument control in the field using a handheld PDA
(Personal Data Assistant). Several models of PDA are supported. Pocket-
Situ uses the same code base as Win-Situ 4. If you have used Win-Situ,
you already know how to use Pocket-Situ.

PRINCIPAL DIFFERENCES BETWEEN WIN-SITU AND
POCKET-SITU

• Installation. Microsoft® ActiveSync™ is needed to install the application
on a PDA and to transfer data files from the PDA to a desktop or laptop
computer. Installation is described below.

• Device Clock display. Due to the screen size, the miniTROLL or
TROLL 9000 real-time clock is not displayed. To insure the device
clock is correct, set the PDA clock if necessary, then synchronize the
device clock as described in Section 2, Getting Started.

• Vertical and/or horizontal scroll bars appear when information exceeds
the PDA screen size.

• To resize the top or bottom of the screen, tap the dividing bar with the
stylus and drag it up or down.

• The software version is displayed in title bar (In Win-Situ, it is acces-
sible on the Help menu.)
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• To select measurement units and other preferences, select the Home
site in the Navigation tree and tap Setup on the command bar. (In Win-
Situ, these settings are on the Options menu.)

• To exit Pocket-Situ, select the Home site in the Navigation tree and tap
Exit on the command bar. (In Win-Situ, Exit is on the File menu.)

• Win-Situ provides more data-file management features than Pocket-
Situ—e.g., printing, exporting to Excel, and better graphing. To take
advantage of these features, be sure to transfer data files from the
PDA to a desktop or laptop PC where Win-Situ is installed. PocketSync
on your desktop computer can do this automatically when an
ActiveSync connection is established. or you can manually copy data
using Microsoft ActiveSync. See the procedure later in this section.

SETTINGS TO CHECK ON A PDA

Consult your PDA documentation for specifics.

• Check the battery and set the clock.

• Most PDAs will “time out” after a period of time with no activity. You
should not let it time out during Profiling, Calibration, or Extracting
large data files. To locate this setting in most PDAs, display the Start
menu, select Settings, System tab, Power.

• For text entry, a keyboard icon is usually displayed in the Command
Bar. The Tab key for moving from field to field is here, as well as the
Control key for making multiple selections.

• The PDA may require a reset if it stops responding. Some PDAs have
a “hard reset” and a “soft reset.” Pocket-Situ data files are stored in
non-volatile memory and will not be lost, but it is a good idea to select
“Repair/Re-Install Pocket-Situ” in PocketSync on the desktop PC after
a device reset.

SECTION 10: POCKET-SITU
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INSTALLATION

The In-Situ synchronization utility PocketSync can automatically install or
update Pocket-Situ on a connected RuggedReader or other handheld
PDA. It also transfers files between the connected PDA and a desktop PC
easily and automatically. the Win-Situ/Pocket-Situ CD-ROM.

You will need—

• Microsoft® ActiveSync® synchronization software installed on your
desktop computer. ActiveSync came with your PDA, or may be
obtained from the Microsoft web site (www.microsoft.com/
windowsmobile)

• An In-Situ RuggedReader or other handheld PDA running Microsoft
Pocket PC, Pocket PC 2002, or Pocket PC 2003, which is also known
as Windows Mobile 2003

• At least 16 megabyte capacity for storage of Pocket-Situ data on the
PDA (SD card, CF card, or the device’s permanent storage)

• The Win-Situ/Pocket-Situ installation CD-ROM

1. Install Microsoft ActiveSync on the desktop PC.

2. Connect the computers. If this is
your first connection, follow the
prompts in ActiveSync to set up a
Standard partnership or a Guest
partnership. PocketSync can work
with either type of partnership.

SECTION 10: POCKET-SITU

TIP: Windows 95
and Windows NT
do not support

USB. If using a PC with
either of these operating
systems, you will need to
connect using the 9-pin
serial communication ports
on each computer. An
optional serial communica-
tions cable will be required.

2
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3. Install Win-Situ 4 on your desktop PC from the Win-Situ/Pocket-Situ
CD.

4. Install Pocket-Situ on the desktop PC from the CD. Install it to the
same folder as Win-Situ.  Note: The CD menu option is “Install Pocket-
Situ,” but you are actually installing the PocketSync utility to your
desktop computer. PocketSync will install Pocket-Situ on a connected
PDA.

5. When the connection is established, the desktop utility PocketSync
launches and begins its automatic synchronization. To install Pocket-
Situ on the PDA, do one of the following:

SECTION 10: POCKET-SITU
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• If Pocket-Situ is not installed on the PDA, as shown in the screen
above, or needs an update, you will be asked if you want to install it.
Click Yes.

• Or, after synchronization is complete, click the Tools menu and
select Un-Install Pocket-Situ to remove an earlier version, then
choose Repair/Re-Install Pocket-Situ to install the newest version.

Connect to a miniTROLL or MP TROLL 9000, and Pocket-Situ is ready to
run. Note that a null modem adapter is needed with customer-acquired
PDAs other than the RuggedReader.

TRANSFERRING FILES FROM A PDA TO A DESKTOP PC

TRANSFERRING FILES AUTOMATICALLY

If PocketSync is installed on your desktop computer, it can automatically
scan the connected PDA for extracted test data files and transfer them to
the Win-Situ folder on your desktop or laptop PC for processing or
archiving.

TRANSFERRING MANUALLY

If you wish to transfer files manually, follow the procedure below using
Microsoft ActiveSync.

1. With the computers
connected and
ActiveSync running,
open up Explore on the
ActiveSync tool bar.

SECTION 10: POCKET-SITU

1

Exit Pocket-Situ
before
establishing

communication between the
computers in ActiveSync.
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2. Double-click on “My
Pocket PC.”

3. Browse to the folder
where Pocket-Situ Data
is stored. On many
PDAs this will be in a
folder called “Storage
Card” or “SD Card.” On
the Rugged Reader,
look in Built-in Storage. Open the Pocket-Situ Data folder (double-click)
to display a listing of your
extracted data (.bin) files.

4. Right-click the file(s) you
want to transfer and
select Copy or Cut.
Selecting Cut will remove
the data file from the
PDA.

5. Open Windows Explorer
for the desktop PC and
navigate to the folder where you want to place the data file(s). When
the cursor is in the desired folder, right-click, and select Paste.

We recommend placing the files in the following locations to ensure
that they will be displayed properly in the Data Folder branch of the
Win-Situ Navigation tree.

Test data files Data folder in the folder where Win-Situ is
installed (normally, C:\Win-Situ\Data)

Low flow files LowFlow subfolder of the Data folder

SECTION 10: POCKET-SITU

2

4

TIP: Calibration
reports in HTML
format are located

in the Calibration Reports
folder. Low flow files are
located in the LowFlow
subfolder under the Data
folder.

TIP: To copy low
flow files from a
desktop PC to a

Pocket PC, reverse this
procedure: (1) Copy the file
in Windows Explorer on the
desktop PC, (2) use
ActiveSync Explorer to
browse to the LowFlow
subfolder under the Data
folder in the folder where
Pocket-Situ is installed on
the PDA, (3) paste the file.

With both Explorers open,
you may “click and drag”
files between them.
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SECTION 10: POCKET-SITU

TROUBLESHOOTING SOFTWARE CONNECTIONS

DESKTOP COM PORT CONFLICTS

Windows 95 and Windows NT do not support USB.  If using a PC with
either of these operating systems, you will need to connect using the 9-pin
serial communication ports on each computer.  An optional serial
communications cable will be required.

Note that both Pocket-Situ on the PDA and Win-Situ on the PC will use
the same serial COM ports to communicate with instruments as Microsoft
ActiveSync will be trying to use to communicate between the two
computers. Before attempting serial port communications in Microsoft
ActiveSync make certain that you drop any active connections with
instruments (highlight the connection line in the Navigation Tree and hit
the Drop button) and close both Pocket-Situ (highlight the Home level in
the Navigation Tree and tap the Exit button) on the PDA and Win-Situ on
the PC.
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11 FLOW-SENSE WIZARD

In-Situ’s low-flow software can help to determine when a representative
sample of formation water can be collected from a well for analysis.
Based on user input, the software automatically calculates the volume of
the In-Situ flow cell and the tubing, and the time to exchange one
complete volume at the specified pumping rate. The frequency of
measuring the water-quality indicator parameters is based on the time
required to completely evacuate one volume of the flow cell and tubing.
Meter and graphical views help to determine when the change in
parameter readings falls within the specified target range.

PREPARATION

• Insure Win-Situ is installed on your desktop/laptop PC and Pocket-Situ
is installed on the handheld PDA you intend to use in the field

• Calibrate the water-quality sensors of the MP TROLL 9000

• Insert the MP TROLL 9000 into the Low-Flow Flowcell and connect the
valves and tubing. Connect the tubing to the pump.

• Start the pump and determine optimum final pumping rate.

• Have the following site information ready:

• Well diameter

TIP: For
complete
calibration

information, refer to the
Multi-Parameter TROLL
9000 Operator’s Manual on
the Win-Situ 4 installation
CD.
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• Total well depth
• Depth to water level, referenced to a benchmark
• Depth to top of screen and placement of pump intake, referenced to

the same benchmark
• Screen length
• Pump model & type
• Tubing type, inner diameter & length
• Final pumping rate (in mL/min)
• Final stabilized drawdown from static water level, measured with a

tape or other measurement device after the final pumping rate has
been established

• Connect the MP TROLL 9000 to the PC’s COM port

• Install Microsoft® ActiveSync™ on a desktop or laptop PC to enable
transfer of files to and from a PDA. ActiveSync must be installed before
connecting the computers for the first time.

OPTIONAL PREPARATION

• Text entry on a PDA in the field can be tedius. To simplify the task, you
may wish to run the Flow-Sense Wizard from Win-Situ on a full-sized
PC in the office to prime the software with representative values. Then
use ActiveSync to copy the “templates” created in this way to a PDA on
which Pocket-Situ is installed. See “Priming the Flow-Sense Wizard in
the Office” at the end of this section.
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USING THE FLOW-SENSE WIZARD

START THE SOFTWARE

Launch Win-Situ or Pocket-Situ.

If you have not used the software before, take a moment to specify a
connection type, COM port, and baud rate. Refer to Step 3 in Section 2
(Getting Started) of this guide for specifics.

LAUNCH THE FLOW-SENSE WIZARD

Select one of the following ways to launch the Flow-Sense Wizard:

• Select the Flow-Sense Wizard from the Tools menu in Win-Situ (not
available in Pocket-Situ)

• Select the Flow-Sense Wizard in the Navigation tree. Click or tap Start
in the Information pane.

Select the Wizard

Click Start

1

2

TIP: Win-Situ
screens are
illustrated here.

The Pocket-Situ interface is
similar, with the Navigation
tree at the top of the screen
and the Information pane
below it.
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• If you’ve used the Flow-Sense Wizard before—or copied “template”
files from a different PC—expand the Flow-Sense Wizard folder by
clicking on the +, then expand the Flow-Sense Data folder. Select a file
or template and click or tap Start from template. Input values from
that file or template will be copied in. For more on “template” files, see
“Priming the Flow-Sense Wizard in the Office” at the end of this
section.

Select a .flo file
or template

Click Start

1

2



79SECTION 11: FLOW-SENSE WIZARD

rev. 003  11/04

Verify Unit Preferences

Before the Flow-Sense Wizard starts, you may wish to verify the current
unit selections. Length measurements in the Flow-Sense Wizard default to
metric (meters, centimeters), but you can enter and display this data in
English units (feet, inches) if you prefer. You may also wish to verify the
units for Conductivity, Dissolved Oxygen, ORP, pH, Temperature, and
Turbidity.

To skip the settings verification, click Continue.

The Wizard will open the COM port and connect to the instrument. If you
have used the Wizard before, or launched the Wizard from an existing .flo
file, data entry values will be supplied.

TIP: Flow units in
the Flow-Sense
Wizard will

always be in milliliters (mL).
For best results, units
should be consistent
between the desktop
application and the PDA
application.

TIP: The Wizard
opens the COM
port you used

last (this is stored in the
Wizards.ini file in the Config
subfolder in the folder
where Win-Situ is installed).

If several connections have
been used in the past, the
Wizard uses the first “direct”
connection it encounters in
the tree.

If the Wizard is started
without any connection
information, at all, it will
attempt to connect using
COM 1 at a baud rate of
19200.
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1. The first input screen provides for entry of specific details about the
project. This information will be included in the output report. The
Project Name and Site Name will appear in the output file name.

Click or tap Next to continue.

Project Information



81SECTION 11: FLOW-SENSE WIZARD

rev. 003  11/04

2. In the next screen, enter information about the well. This information
will be included in the output report. The Well I.D. will appear in the
output file name.

Click or tap Next to continue.

Well Information
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3. In the next screen, enter details about the pump and tubing. Tubing
information is used in later volume calculations.

Click or tap Next to continue.
Pump Information
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4. The next screen requests pumping information

Final pumping rate: Enter in milliliters per minute.

Total volume—Auto Calculated Value: This is the software-
calculated volume of the cup (In-Situ Low-Flow Flowcell) and tubing,
less the displacement of installed sensors.

To specify a different volume, clear the “Auto” check box, and enter the
new volume (milliliters).

Pumping
Information: Total
Volume

TIP: you may
override the
calculated

volume if you wish, for
example if you are using a
different flow cell.
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Measurement interval—Auto Calculated Value: This is the software-
calculated time (seconds) for one complete exchange of water in the
calculated volume at the final pumping rate. In other words, this is the
time required to completely evacuate one volume of the flow cell and
tubing and draw in a new volume. Readings will be taken at this
interval unless you specify a different interval.

To specify a different interval, clear the “Auto” check box as shown
above, and enter the desired measurement interval (seconds).

Stabilized drawdown: Final drawdown from the initial water level
entered previously.

Click or tap Next to continue.

Pumping
Information:
Measurement
Interval

TIP: You may
override the
calculated

measurement interval if you
wish to read parameters at
a different interval than
once per volume exchange.
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Select Channels &
Stabilization

5. The final screen displays the Low Flow parameters. Choose the
parameters to monitor and the stability range for each parameter.

The percentage range is calculated by the formula:

If no percentage ranges are entered, the software will monitor absolute
values values to determine stabilization. If any percentage range is
entered, the software will monitor percentage change.

Click the Notes button to add comments, if you want. They will be
included in the output report.

TIP: If a
parameter you
wish to monitor is

greyed out, be sure the
sensor is properly installed.
Refer to the Multi-
Parameter TROLL 9000
Operator’s Manual on the
Win-Situ 4 installation CD,
or to installation instructions
shipped with the water
quality sensors.

max - min of last 3 readings

last reading
× 100%
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6. Ensure the pump is on, then click or tap Start to begin the stabilization
readings.

STABILIZATION READINGS

The next screen shows for each parameter:

• Reading: the current reading
• Change - Val: difference between the maxium and minimum

over the last 3 readings OR
• Change - %: difference between the current reading and the

third reading back (two readings ago) expressed as a
percentage

• Target specified earlier in the Wizard (shown for Values)

To view this data in graphical form, click Graph.

Time the Wizard started Elapsed time
No. of readings taken Countdown to next

reading

TIP: In any view,
the Back button
may be used to

change the input on any
earlier screen. The program
will pause, then resume
when you are ready.
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The graph shows the change and stabilization ranges of all parameters.

The central area of the graph (the “change band”), between the heavy
dotted lines, represents a composite target of all specified stability ranges.
The range finder on the right may be dragged up or down, or the stabillity
region may be expanded to zoom in on the readings.

The most recent readings are shown on the right of the graph, with earlier
readings on the left. 0 designates the latest reading. The change band is
centered on the third point as a reference. The graph can show up to 10
sets of readings. Change is recalculated and displayed with each reading.

The Meter button returns to the previous screen.

When you are ready to save the data and exit the software, click or tap
Accept.

Graph View

Graph view of stabilized changeGraph view of unstable change
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SAVING THE LOW FLOW DATA

Click Save when a suggested output file name is displayed. You may
change this name if you like. After it is saved, the file will be displayed in
the Data Folder branch of the Navigation tree and will open in the
Information pane, like other test files extracted in Win-Situ or Pocket-Situ.

The file may be displayed in report format or as a graph in both Win-Situ
and Pocket-Situ. (If you can’t see much on the PDA screen, try scrolling to
the right.) The top of the file presents well, site, and project information. At
the end of the file are the measurement data.

Additional functions are available through Win-Situ (desktop or laptop PC).

• Print (file menu)
• Graph (button in Information pane) However, note that better

graphical report output is available if you export to Excel
• Save as text file (file menu)
• Export to Excel (file menu)

OUTPUT

Low-Flow files are saved as files of type .flo in a folder named Flow-Sense
Data under the Flow-Sense Wizard folder, and are accessible in the
Navigation tree. By default they are named as shown below:

Flow-Sense Data \ Central Valley-New West Well-1562-3-10-2003.flo

Project name

Site name

Well ID

Date (m-dd-yyyy)

Low flow file designator

TIP: To take full
advantage of
Win-Situ’s output

file formatting, we
recommend you transfer
the low flow data files from
the PDA to a desktop or
laptop PC. For help, see the
procedure in Section 10 of
this guide.
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EXPORT TO EXCEL OPTION

To automatically create an output report in Microsoft® Excel™ from Win-
Situ

1. In the Win-Situ Navigation tree, select a low flow data file. If it opens in
Graph view, select the Report button.

2. On the Win-Situ File Menu, select Export to Excel.

3. The report will open in an Excel spreadsheet.

Using a Custom Excel Template

The Win-Situ Low Flow installation includes an Excel template for creating
an output report (shown on the following page). This template is named
InSituLowFlow.xlt, and is automatically installed to the Templates directory
of the Microsoft operating system. Brief instructions for using this template
are included in the spreadsheet that opens when you select Export to
Excel.

To format an output report using the custom template,

1. After exporting a low flow data file to Excel, insert a new sheet based
on a template by right-clicking the tab at the bottom of the screen.

2. Click Insert, then select the template InSituLowFlow.xlt.

3. When prompted by Excel, select “Enable Macros.”

An example of low flow data formatted in Excel using this template is
shown on the following page.

4. If desired, save the report as an .XLS file.

TIP: If Excel is
not set up to run
macros, you may

be asked how you wish to
handle the macros in this
template. For best results,
be sure to Enable the
Macros.

TIP: To export
low flow data to
Excel, first

transfer the low flow data
file(s) from the PDA to a
desktop or laptop PC and
open them in Win-Situ.
Instructions for transferring
data files are given in
Section 10 of this guide.
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Sample Output
Report
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Sample of a Low-Flow output report using the Export to Excel function and the In-Situ
template InSituLowFlow.xlt Normalized data = change in indicator parameters mapped
from 0 to 1
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PRIMING THE FLOW-SENSE WIZARD IN THE OFFICE

To reduce the need for input on a PDA in the field, you may want to use
the following procedure to prepare the majority of Low Flow information on
your desktop PC ahead of time.

On the Desktop PC

1. Connect the TROLL 9000 you will use in the field to your desktop PC.

2. Create .FLO “template” files on desktop PC in preparation for going out
into the field, as follows:

For each well you need to sample, execute the Wizard and enter
reporting information. You may click Finish immediately (the sampled
data is unimportant), but be sure to run the Wizard for each well you
intend to visit and enter that well’s information.

When the Wizard asks if you want to save the file, give each one a
meaningful name, for example:

“Well abc template.flo”
“Well xyz template.flo”

3. On your next ActiveSync connection, In-Situ’s synchronization utility
PocketSync will prompt you for Low Flow templates you wish to
transfer to the PDA.

TIP: If Pocket
Sync does not
prompt for this,

click Send Low Flow Files
on the File menu.
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In the Field

4. Connect the TROLL 9000 to the PDA and navigate to the Flow-Sense
Wizard/Flow-Sense Data branch of the tree. Locate the template file
you created for the well you are sampling. Highlight that file in the tree
and tap Start from Template. The highlighted file will be used to
initialize the Wizard so that you don’t have to type as much on the
PDA.

5. Verify that the PDA settings for units used in low flow sampling are the
same as those of your desktop. These include “Low Flow units” and
units for sensors used.

6. Note that you will need to adjust Final Pumping Rate and other
variables. Let the Wizard run to stabilization.

7. Save this file (with real data) under a different name than the template
file you created on your PC. The Wizard’s default file name consists of
the Project name, Site name, Well I.D., and date, but you can rename
the file any way you like.

In the Office

8. Connect the computers in ActiveSync and the PocketSync utility will
automatically copy the resultant .FLO files back to the PC.

Note: In future visits to the same well you can re-use files from last time.
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The conversion from PSI units to meters or feet of water requires several
conversion factors. One of these is the density (ρ) of the aqueous solution
being monitored. Pure groundwater at 20°C has a density of 0.998 grams
per cubic centimeter (g/cm3).

Use the values in the table below for density if you do not otherwise know
it. However, since these data assume pure water, there is no accommo-
dation for other variables (such as salinity) which can affect your actual
water conditions. (Alternatively, you could compute it; see the following
procedure.)

Temp. Density Temp. Density Temp. Density
(°C) (g/cm3) (°C) (g/cm3) (°C) (g/cm3)

1 0.999900 11 0.999605 21 0.997992
2 0.999941 12 0.999498 22 0.997770
3 0.999965 13 0.999377 23 0.997538
4 0.999973 14 0.999244 24 0.997296
5 0.999965 15 0.999099 25 0.997044
6 0.999941 16 0.998943 26 0.996783
7 0.999902 17 0.998774 27 0.996512
8 0.999849 18 0.998595 28 0.996232
9 0.999781 19 0.998405 29 0.995944
10 0.999700 20 0.998203 30 0.995646

APPENDIX A:
LIQUID DENSITY
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DETERMINING DENSITY

The density of water in a well can be determined using an accurate tape
measure and a pressure transducer. A change in pressure is recorded
between two points as the transducer is lowered into the water and the
corresponding change in depth is recorded using the measuring tape.
Density is then calculated using a simple formula. This method is valid if
the pressure and depth measurements are accurate and the water within
the well is homogeneous throughout the entire depth of the well.

Note: Density can also be measured using a hydrometer if it is possible to
withdraw a water sample from the well. We recommend an accuracy of
±0.0005

Procedure

There are two possible methods for measuring the change in water depth.
Choose the method that is the most convenient and accurate.

• Attach the tape measure to the transducer cable using an adhesive
(e.g., duct tape). The tape measure can be attached to the transducer
itself or to a segment of the cable that will be adjacent to the top of the
well casing. Read the cable positions directly from the measuring tape.
The measuring device must have a resolution of at least 1 mm or 1/16
in.

• Alternatively, mark the positions of the cable with a felt tip pen. The
distance between marks is then determined with a tape measure after
the corresponding cable segment is removed from the well.

1. Lower the transducer into the well until it is submerged under about
one meter of water.

2. Secure the transducer at a fixed depth using the cable at the top of the
well casing. Wait an hour or so for the system to equilibrate.

TIP:  If using a
tape measure
calibrated in feet,

1 ft  =  0.3048 m (exactly).

APPENDIX A: LIQUID DENSITY
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3. Take an electronic pressure reading, manually, from the transducer
and record this measurement in PSI.  This is measurement P

1
.

4. Read the tape measure relative to some fixed reference point (e.g., top
of well casing) or mark the position on the cable with a felt tip pen.
This is measurement L

1
.

5. Lower the transducer at least three meters deeper into the water and
repeat steps 3 and 4.  These are measurements P2 and L2.

6. Density (ρ) in g/cm3 is calculated using the following:

where g is the gravitational acceleration for the location of the well in m/s2.
P must be in PSI units and L must be in meters.

g   x   (L2 - L1)

(P2 – P1)   x   6.894757
ρ   =

APPENDIX A: LIQUID DENSITY



96WIN-SITU 4.0 USER’S GUIDE

rev. 003  11/04

APPENDIX B: TEST
MEASUREMENT SCHEDULES

LINEAR

In Linear sampling, the selected channels are measured at the same
regular, unvarying Measurement Interval, and all measurements are
stored to the device memory. All channels share the same Measurement
Interval.
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EVENT

This is much like Linear sampling with one important difference. All
selected parameters are measured at your chosen Measurement Interval,
but the measurements are stored as data only if the measurements on the
designated “event” channel exceed a user-defined value. This value is
called “Delta” because it relates to some change in the measurement
which the probe observes. Here’s how it works.

Delta

Each measurement on the selected Event channel is compared to a
reference data point. The initial reference is taken at the start of the test. If
a measurement varies from the reference by less than the Delta amount,
the measurement is not stored. If a measurement varies from the
reference by more than the Delta amount, the measurement is stored.
This stored data point is called a “Delta point” and becomes the new
reference for comparison. In this manner, you can design a test whereby
small and essentially insignificant changes are not stored into the data file,
but larger and more significant changes measured by the probe are
stored. This acts to minimize the size of a data file but stores all
meaningful data.

Minimum Delta Values

System accuracy is a function of many variables (sensor range, digital
resolution, etc.). It is theoretically possible to choose a Delta value so
small that random system noise, however slight, might “look” significant.
We recommend that you enter a reasonable Delta value for the parameter
being measured to avoid triggering an event storage when no event has
occurred.

APPENDIX B: TEST MEASUREMENT SCHEDULES

TIP: Units for the
Event channel
should be set to

the “basic” parameter unit
(e.g., psi); derived
(software-calculated) units
are not available.
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Default Storage

In addition to Delta points, another form of data is also stored. Consider a
situation where there is virtually no change through time in measured
value from the probe. In this case, it is possible that almost no data would
be stored to the data file. To avoid the scenario of a long-term test
containing virtually no stored data, sparse linear sampling also occurs
whereby data points are stored to the data file every n measurements
regardless of the measurement comparisons that are occurring. This type
of data is called “default storage.” For example, if the Measurement
Interval is 10 minutes and you specify a Default storage every 6
measurements—as shown in the event test setup screen below—then
data will be logged every hour regardless of the Delta comparisons.

APPENDIX B: TEST MEASUREMENT SCHEDULES

Measurement Interval

“Delta” value Default storage
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LOG

Logarithmic (or simply “log”) sampling optimizes data collection speed and
memory usage for pump and slug tests. These tests characteristically
begin with very rapid changes in values, and end with very slowly
changing values. If you were to program a very fast linear rate, you could
characterize the early stages of the test, but you would be quickly
inundated with excessive data during the later stages of the test, possibly
running out of memory before the test is complete. Conversely, a slower
linear rate would allow you to run a test longer, but would not provide
enough early-time information to properly characterize the data.

Log sampling solves this problem with a schedule where the measure-
ments begin closely spaced and the interval between measurements
continuously increases. The sensor is measured at a logarithmically de-
creasing rate (i.e., continually increasing time interval between any two
points), taking 40 log-normally distributed measurements per log decade
of time.

For reference, the entire log schedule out to the 218th data point is shown
iin Appendix D.

Linearization Interval

The interval between measurements will continually lengthen, but your
specified Measurement Interval serves as a “linearization” value such that
the interval between measurements will never become greater than this
value. For example, with a Measurement Interval of 20 minutes, the
logger’s sampling interval lengthens until a 20 minute interval is reached,
then it begins to sample linearly from that time on at 20-minute intervals.

APPENDIX B: TEST MEASUREMENT SCHEDULES
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APPENDIX B: TEST MEASUREMENT SCHEDULES

First Six Seconds of Test

In a true logarithmic sampling scheme, the interval between points would
be infinitely short at time t=0 (the start of the test), which implies infinitely
rapid sampling. The logger cannot sample faster than once every 300
milliseconds (about 31/

3 
points per second). Thus, a linear sampling rate of

one point each 300 milliseconds occurs for the first 6 seconds into the
test, then the logarithmic decline begins with the 21st data point at the 6
second mark.
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TIP: The storage
interval (A) must
be at least twice

as long as the rapid interval
(B) times the number of
Measurements for
averaging (C). In the
example below, 5 seconds
x 3 = 15 seconds, so the
storage interval would have
to be at least 30 seconds.

LINEAR AVERAGE

This type of test can eliminate anomalous highs and lows that may
occur—for example, if a wave passes over the instrument at the time a
measurement is made. For every measurement stored in the data file, the
device takes a specified number of measurements at a specified interval,
averages them, and stores the average value.

You are prompted for

A the storage interval (how often an averaged measurement will be
stored in the data file)

B the interval between the rapid measurements that will be averaged
(1-255 seconds)

C the number of measurements that will be averaged for each stored
measurement (2-99)

In the event test example shown in the screen below, a measurement will
be logged every hour (A). The logged measurement will consist of the
average of 5 measurements (C) taken 3 seconds apart (B).

APPENDIX B: TEST MEASUREMENT SCHEDULES
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APPENDIX C: THE
LOG SCHEDULE

For reference, the entire log schedule out to the 218th data point is shown
on the following pages. The first column shows the data point number (N).
The next four columns show the time between any two data points. The
last five columns show the elapsed time (time since the test started) of any
given data point.

N = Data Point Number

             TIME TO NEXT POINT                  ELAPSED TIME

 N hr min sec hdrd day hr min sec hdrd

  1 0 0 0 30 0 0 0 0 0
  2 0 0 0 30 0 0 0 0 30
  3 0 0 0 30 0 0 0 0 60
  4 0 0 0 30 0 0 0 0 90
  5 0 0 0 30 0 0 0 1 20
  6 0 0 0 30 0 0 0 1 50
  7 0 0 0 30 0 0 0 1 80
  8 0 0 0 30 0 0 0 2 10
  9 0 0 0 30 0 0 0 2 40
 10 0 0 0 30 0 0 0 2 70
 11 0 0 0 30 0 0 0 3 0
 12 0 0 0 30 0 0 0 3 30
 13 0 0 0 30 0 0 0 3 60
 14 0 0 0 30 0 0 0 3 90
 15 0 0 0 30 0 0 0 4 20
 16 0 0 0 30 0 0 0 4 50



103

rev. 003  11/04

N = Data Point Number

             TIME TO NEXT POINT                  ELAPSED TIME

 N hr min sec hdrd day hr min sec hdrd

 17 0 0 0 30 0 0 0 4 80
 18 0 0 0 30 0 0 0 5 10
 19 0 0 0 30 0 0 0 5 40
 20 0 0 0 30 0 0 0 5 70
 21 0 0 0 35 0 0 0 6 0
 22 0 0 0 37 0 0 0 6 35
 23 0 0 0 39 0 0 0 6 72
 24 0 0 0 42 0 0 0 7 11
 25 0 0 0 44 0 0 0 7 53
 26 0 0 0 47 0 0 0 7 97
 27 0 0 0 50 0 0 0 8 44
 28 0 0 0 53 0 0 0 8 94
 29 0 0 0 56 0 0 0 9 47
 30 0 0 0 59 0 0 0 10 3
 31 0 0 0 63 0 0 0 10 62
 32 0 0 0 66 0 0 0 11 25
 33 0 0 0 70 0 0 0 11 91
 34 0 0 0 75 0 0 0 12 61
 35 0 0 0 79 0 0 0 13 36
 36 0 0 0 84 0 0 0 14 15
 37 0 0 0 89 0 0 0 14 99
 38 0 0 0 94 0 0 0 15 88
 39 0 0 1 0 0 0 0 16 82
 40 0 0 1 6 0 0 0 17 82
 41 0 0 1 12 0 0 0 18 88
 42 0 0 1 19 0 0 0 20 0
 43 0 0 1 26 0 0 0 21 19
 44 0 0 1 33 0 0 0 22 45
 45 0 0 1 41 0 0 0 23 78
 46 0 0 1 49 0 0 0 25 19
 47 0 0 1 50 0 0 0 26 68
 48 0 0 1 60 0 0 0 28 18
 49 0 0 1 70 0 0 0 29 78
 50 0 0 1 80 0 0 0 31 48

APPENDIX C: THE LOG SCHEDULE
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N = Data Point Number

             TIME TO NEXT POINT                  ELAPSED TIME

 N hr min sec hdrd day hr min sec hdrd

 51 0 0 1 90 0 0 0 33 28
 52 0 0 2 10 0 0 0 35 18
 53 0 0 2 20 0 0 0 37 28
 54 0 0 2 30 0 0 0 39 48
 55 0 0 2 50 0 0 0 41 78
 56 0 0 2 60 0 0 0 44 28
 57 0 0 2 80 0 0 0 46 88
 58 0 0 2 90 0 0 0 49 68
 59 0 0 3 10 0 0 0 52 58
 60 0 0 3 30 0 0 0 55 68
 61 0 0 3 50 0 0 0 58 98
 62 0 0 3 70 0 0 1 2 48
 63 0 0 3 90 0 0 1 6 18
 64 0 0 4 20 0 0 1 10 8
 65 0 0 4 40 0 0 1 14 28
 66 0 0 4 70 0 0 1 18 68
 67 0 0 5 0 0 0 1 23 38
 68 0 0 5 30 0 0 1 28 38
 69 0 0 5 60 0 0 1 33 68
 70 0 0 5 90 0 0 1 39 28
 71 0 0 6 30 0 0 1 45 18
 72 0 0 6 60 0 0 1 51 48
 73 0 0 7 0 0 0 1 58 8
 74 0 0 7 50 0 0 2 5 8
 75 0 0 7 90 0 0 2 12 58
 76 0 0 8 40 0 0 2 20 48
 77 0 0 8 90 0 0 2 28 88
 78 0 0 9 40 0 0 2 37 78
 79 0 0 10 0 0 0 2 47 18
 80 0 0 10 60 0 0 2 57 18
 81 0 0 11 20 0 0 3 7 78
 82 0 0 11 90 0 0 3 18 98
 83 0 0 12 60 0 0 3 30 88

APPENDIX C: THE LOG SCHEDULE



105

rev. 003  11/04

N = Data Point Number

             TIME TO NEXT POINT                  ELAPSED TIME

 N hr min sec hdrd day hr min sec hdrd

 84 0 0 13 30 0 0 3 43 48
 85 0 0 14 10 0 0 3 56 78
 86 0 0 14 90 0 0 4 10 88
 87 0 0 15 80 0 0 4 25 78
 88 0 0 16 80 0 0 4 41 58
 89 0 0 17 80 0 0 4 58 38
 90 0 0 18 80 0 0 5 16 18
 91 0 0 19 90 0 0 5 34 98
 92 0 0 21 10 0 0 5 54 88
 93 0 0 22 40 0 0 6 15 98
 94 0 0 23 70 0 0 6 38 38
 95 0 0 25 10 0 0 7 2 8
 96 0 0 26 60 0 0 7 27 18
 97 0 0 28 20 0 0 7 53 78
 98 0 0 29 90 0 0 8 21 98
 99 0 0 31 60 0 0 8 51 88
100 0 0 33 50 0 0 9 23 48
101 0 0 35 50 0 0 9 56 98
102 0 0 37 60 0 0 10 32 48
103 0 0 39 80 0 0 11 10 8
104 0 0 42 20 0 0 11 49 88
105 0 0 44 70 0 0 12 32 8
106 0 0 47 40 0 0 13 16 78
107 0 0 50 20 0 0 14 4 18
108 0 0 53 10 0 0 14 54 38
109 0 0 56 30 0 0 15 47 48
110 0 0 59 60 0 0 16 43 78
111 0 1 3 20 0 0 17 43 38
112 0 1 6 90 0 0 18 46 58
113 0 1 10 90 0 0 19 53 48
114 0 1 15 10 0 0 21 4 38
115 0 1 19 50 0 0 22 19 48
116 0 1 24 30 0 0 23 38 98

APPENDIX C: THE LOG SCHEDULE
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N = Data Point Number

             TIME TO NEXT POINT                  ELAPSED TIME

 N hr min sec hdrd day hr min sec hdrd

117 0 1 29 30 0 0 25 3 28
118 0 1 34 50 0 0 26 32 58
119 0 1 40 10 0 0 28 7 8
120 0 1 46 10 0 0 29 47 18
121 0 1 52 40 0 0 31 33 28
122 0 1 59 0 0 0 33 25 68
123 0 2 6 10 0 0 35 24 68
124 0 2 13 60 0 0 37 30 78
125 0 2 21 50 0 0 39 44 38
126 0 2 29 90 0 0 42 5 88
127 0 2 38 80 0 0 44 35 78
128 0 2 48 20 0 0 47 14 58
129 0 2 58 10 0 0 50 2 78
130 0 3 8 70 0 0 53 0 88
131 0 3 19 90 0 0 56 9 58
132 0 3 31 70 0 0 59 29 48
133 0 3 44 30 0 1 3 1 18
134 0 3 57 60 0 1 6 45 48
135 0 4 11 60 0 1 10 43 8
136 0 4 26 60 0 1 14 54 68
137 0 4 42 40 0 1 19 21 28
138 0 4 59 10 0 1 24 3 68
139 0 5 16 80 0 1 29 2 78
140 0 5 35 60 0 1 34 19 58
141 0 5 55 50 0 1 39 55 18
142 0 6 16 50 0 1 45 50 68
143 0 6 38 90 0 1 52 7 18
144 0 7 2 50 0 1 58 46 8
145 0 7 27 50 0 2 5 48 58
146 0 7 54 0 0 2 13 16 8
147 0 8 22 10 0 2 21 10 8
148 0 8 51 90 0 2 29 32 18
149 0 9 23 40 0 2 38 24 8
150 0 9 56 80 0 2 47 47 48

APPENDIX C: THE LOG SCHEDULE
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N = Data Point Number

             TIME TO NEXT POINT                  ELAPSED TIME

 N hr min sec hdrd day hr min sec hdrd

151 0 10 32 20 0 2 57 44 28
152 0 11 9 60 0 3 8 16 48
153 0 11 49 30 0 3 19 26 8
154 0 12 31 30 0 3 31 15 38
155 0 13 15 90 0 3 43 46 68
156 0 14 3 0 0 3 57 2 58
157 0 14 53 0 0 4 11 5 58
158 0 15 45 90 0 4 25 58 58
159 0 16 41 90 0 4 41 44 48
160 0 17 41 30 0 4 58 26 38
161 0 18 44 20 0 5 16 7 68
162 0 19 50 80 0 5 34 51 88
163 0 21 1 40 0 5 54 42 68
164 0 22 16 10 0 6 15 44 8
165 0 23 35 30 0 6 38 0 18
166 0 24 59 20 0 7 1 35 48
167 0 26 28 0 0 7 26 34 68
168 0 28 2 10 0 7 53 2 68
169 0 29 41 80 0 8 21 4 78
170 0 31 27 40 0 8 50 46 58
171 0 33 19 20 0 9 22 13 98
172 0 35 17 70 0 9 55 33 18
173 0 37 23 10 0 10 30 50 88
174 0 39 36 10 0 11 8 13 98
175 0 41 56 90 0 11 47 50 8
176 0 44 26 0 0 12 29 46 98
177 0 47 4 0 0 13 14 12 98
178 0 49 51 30 0 14 1 16 98
179 0 52 48 50 0 14 51 8 28
180 0 55 56 30 0 15 43 56 78
181 0 59 15 20 0 16 39 53 8
182 1 2 45 80 0 17 39 8 28
183 1 6 29 0 0 18 41 54 8
184 1 10 25 30 0 19 48 23 8

APPENDIX C: THE LOG SCHEDULE



108

rev. 003  11/04

185 1 14 35 70 0 20 58 48 38
186 1 19 0 90 0 22 13 24 8
187 1 23 41 80 0 23 32 24 98
188 1 28 39 40 1 0 56 6 78
189 1 33 54 60 1 2 24 46 18
190 1 39 28 50 1 3 58 40 78
191 1 45 22 10 1 5 38 9 28
192 1 51 36 70 1 7 23 31 38
193 1 58 13 60 1 9 15 8 8
194 2 5 13 90 1 11 13 21 68
195 2 12 39 10 1 13 18 35 58
196 2 20 30 70 1 15 31 14 68
197 2 28 50 30 1 17 51 45 38
198 2 37 39 40 1 20 20 35 68
199 2 46 59 90 1 22 58 15 8
200 2 56 53 70 2 1 45 14 98
201 3 7 22 60 2 4 42 8 68
202 3 18 28 70 2 7 49 31 28
203 3 30 14 40 2 11 7 59 98
204 3 42 41 80 2 14 38 14 38
205 3 55 53 60 2 18 20 56 18
206 4 9 52 20 2 22 16 49 78
207 4 24 40 60 3 2 26 41 98
208 4 40 21 50 3 6 51 22 58
209 4 56 58 30 3 11 31 44 8
210 5 14 34 10 3 16 28 42 38
211 5 33 12 40 3 21 43 16 48
212 5 52 57 10 4 3 16 28 88
213 6 13 51 90 4 9 9 25 98
214 6 36 1 10 4 15 23 17 88
215 6 59 29 0 4 21 59 18 98
216 7 24 20 40 5 4 58 47 98
217 7 50 40 10 5 12 23 8 38
218 8 0 0 0 5 20 13 48 48

N = Data Point Number

             TIME TO NEXT POINT                  ELAPSED TIME

 N hr min sec hdrd day hr min sec hdrd

APPENDIX C: THE LOG SCHEDULE
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Index

A
ABEND, 50, 52
ActiveSync, 7, 8, 68, 76, 91
Add... button

add connection, 19
add test, 46

B
Batteries

displaying capacity, 22
notice to replace, 15

Baud rate, 11

C
Calibrate button, 24, 33, 38
Calibration

pressure sensor, 32–33
reports, 73
water quality sensors, 38

Cancel a test, 55

Clock
displaying, 22
setting, 13, 68, 69

Clone button, 51, 56
COM port, 10
Connection type, 10
Connection Wizard, 10, 19, 21
Continuous button (Profiler), 44

D
Data files, 55. See also Tests

exporting to Excel, 67
saving as text files, 67
transferring from PDA, 72

Data Folder, 20, 57, 58–61, 73
Delete button

delete connection, 19, 21
delete test, 55

Delta (event test), 97
Density. See Liquid density
Depth

conversion from pressure, 36
profiling, 43

Depth mode (pressure setup), 35
Device information, 22
Device Wizard, 13, 22
Don't Ask dialogs, 27
Downloading data. See Extracting

data
Drop connection, 21
DTW (distance to water), 37

E
Edit... button

edit connection, 21
edit device, 22
edit parameter, 24
edit test, 51

Elevation, 36
Event test, 48, 97–98
Excel

custom low-flow template, 89
exporting data to, 67, 89

Extracting data, 54
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F
Find button, 11, 15, 21
Firmware upgrade, 31
Flow-Sense Wizard, 75–89

accepting values, 87
creating templates, 76, 91–92
entering target values, 85
finishing, 87
measurement interval, 84
output files, 88
reports, 89
saving data, 88
setting unit preferences, 79
stabilization readings, graph

view, 86–87
stabilization readings, meter

view, 86
starting from a file or tem-

plate, 78
starting from Navigation tree, 77
starting from Tools menu, 77
total volume, 83

Fluid density. See Liquid density

G
Graphing controls

Pocket-Situ, 65
Win-Situ, 62–64

Graphing data, 62–66
low-flow data, 86–87
Profiler data, 42

Gravitational acceleration, 36

H
Head mode (pressure setup), 35
Home site, 10, 16

I
Installation, 8

L
Latitude, 36
Level (pressure setup), 35

conversion from pressure, 36
Level reference, 37
Linear average test, 48, 101
Linear test, 48, 96
Linearization interval, 99
Liquid density, 36, 93
Log (logarithmic) test, 48, 99–100

schedule, 102
Logging data, 45–50

Profiler data, 44
Low-flow software. See Flow-

Sense Wizard

M
Manual readings, 23, 24, 30
Manual start mode, 50
Measurement interval, 49
Measurement schedules, 48, 96–

101
Measurement units. See Units
Memory, displaying, 22
Menus, 26

Microsoft
ActiveSync, 7, 8, 68, 72, 76, 91

Microsoft Excel, 67, 89
MSL (mean sea level), 37

N
Name

connection, 11
device, 30
parameter, 34
test, 47

Navigation tree, 16–25
Connection, 21
Data Folder, 20
Device, 22
Parameters, 23–24
Pocket-Situ, 18
site, 19
test status symbols in, 52
Tests, 25, 45, 52
Win-Situ, 17

P
Parameter Wizard, 34
PDA

settings, 69
time-out, 69
transferring data to desktop

PC, 72
Pocket-Situ

about, 6, 68
differences from Win-Situ, 68–

69

INDEX
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exiting, 14, 69
installation, 8, 70–72
Navigation tree, 18
requirements, 7
Rugged Reader PDA, 7
starting, 10
starting in Profiler mode, 27, 43

PocketSync utility, 8, 69, 70
Preferences

saving, 14
setting, 26, 27–31, 69, 79

Pressure head mode, 35
Pressure sensor

zeroing, 32–33
Profiler.bin files, 44
Profiling, 39–44

changing channel order, 43
changing measurement

units, 43
changing sample rate, 27, 43
exiting the Profiler, 44
graphing data, 42
logging data, 40, 44
retrieving data, 44
starting the Profiler, 23, 40
using Boxcar filtering, 29

Program requirements, 7

Q
Quick Cal button, 23

R
Read button, 24, 30

INDEX

Readings, manual, 24, 30
Refresh button, 22

S
Scheduled start mode, 50
Settings options, 27
Site, 19
SnapShot button (Profiler), 44
Specific gravity, 36
Start a test, 53
Status bar, 12
Stop a test, 53
Surface mode (pressure setup), 35

T
Test Wizard, 46
Tests

about, 45
adding to device, 46
cancelling, 55
cloning, 56
deleting from device, 55
event, 48, 97–98
extracting, 54
linear, 48, 96
linear average, 48, 101
log, 48, 99–100
operations, 51
parameters to include, 47
setting up, 46
start mode, 50
starting, 53

status symbols in Navigation
tree, 50, 52

stopping, 53
TOC mode (pressure setup), 35
Toolbar, 26
Top of Casing mode (pressure

setup), 35

U
Units

saving, 14
selecting, 26, 27, 79

Upgrading
features, 31
firmware, 31

V
Viewing test data, 57–67

W
Win-Situ

about, 6
exiting, 14
installation, 8
Navigation tree, 17
requirements, 7
starting, 9
starting in Profiler mode, 27, 43
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